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Digidesign, Inc. warrants the R1 Remote Controller to confiorm substantially to the Specifications set forth on page 5 of this manual when used
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DICIDESICN END USER LICENSE ACREEMENT

NOTICE TO END USERS: CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT FRIOR TO USING THE SOFTWARE FROVIDED WITH THE
AGREEMENT {Session ™), USE OF THE SOFTWARE CONSTITUTES YOUR ACCEPTANCE OF THESE TERMS. IF YOU DO NOT AGREE TO THE
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Radio and Television Interference

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the instruction,
may cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the follow-
ing measures:

* Recrient or relocate the receiving antenna.
= Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

If necessary, consult an experienced radio/television technician for additional suggestions. The
following booklet prepared by the Federal Communications Commission may also be helpful:
“How to Identify and Resolve Radio-TV Interference Problems.” The booklet is available from the
U.S. Government Printing Office, Washington, DC 20402 Stock No. 004-000-00345-4

Changes or modifications not expressly approved by Digidesign could void the user's authority to
operate the R1 Remote Controller.

Important Safety Instructions!
When using electric products, basic precautions should always be followed, including the following:
= Read all instructions before using this product.
* Do not use this product near water (for example, a bathtub, sink, etc.) or if the unit is wet.

« The product should be located away from all sources of heat, such as radiators, heat
registers or other devices that produce heat.



» The product should be connected only to the correct power supply as indicated on the
product.

* The power cord should be unplugged when the product is not in use for an extended
period of time.

= Do not attempt to service the product. Refer all servicing to Digidesign.

* Any attempt to service the product will expose you to a risk of electric shock, and will
void the manufacturer’s warranty.

Digidesign’s Registered User Customer Support Policy

Digidesign will provide telephone support to registered users for a period of one year from the date
of original purchase. As a new R1 owner, the first action you should take is to send in your
registration card. You must be a registered owner if you want to receive telephone support,
program updates, or new product information. Once you are a registered owner, program updates
will be made available to you for a minimal charge.

Digidesign is serious about customer support, and is strongly committed to a continuing relation-
ship with you after your purchase. As a registered R1 owner, you can contact Digidesign directly
with any questions or problems. An R1/5ession 8 Technical Support person will be standing by to
help you during business hours (Monday to Friday, 9:30 to 5:30 PST). For customer service, call
(415) 688-0600.

Digidesign is made up of people who are very interested in audio and the recording process as a
whole. Become one of our registered owners and participate in the creative process.
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Introduction to the RT Remote
Controller

What is the R1 Remote Controller?

The R1 Remote Controller is a MIDI controller for Digidesign's Session 8™ digital recording
and editing systems. The R1 Remote Controller allows you to control on-screen parameters
with sliders, knobs and buttons as an alternative to using the mouse.

Designed specifically to enhance tracking, editing and mixing in Session 8, the R1 features
eight track faders, one master fader, transport controls, four rotaries, a talkback button, and
a numbert of software-specific function keys.
The complete R1 Remote Controller package consists of three basic elements:

= The R1 Remote Controller

* Two MIDI cables to connect the R1 to your MIDI interface

* One Macintosh serial cable (for use with a Macintosh computer)

* One Session 8 Master Disk
Together, this package provides complete hardware control for all the parameters you adjust
most often during recording — track record-enable, track volume, panning, solo, mute, EQ,
effects, autolocate markers, etc. Also, you can use any combination of mouse, R1 and

computer keyboard, at any time. Read on to learn how to start using the R1 to enhance
your recording projects.

Chapter A: Introduction to the R1 Remote Controller 3



About this Manual

This manual is organized to get you up and running with the R1 as quickly as possible.
Please take the time to carefully read it to get fully acquainted with your R1.

» Chapter A, Introduction gives you the system requirements of the R1.

« Chapter B, Installing the R1 Hardware and Software, tells you everything you need to
do to successfully install the R1.

» Chapter C, Overview, gives you an introduction to the various sliders, buttons and
knobs of the R1.

» Chapter D, Using the R1, shows you how to use the R1 for controlling Session 8 —
how to record tracks, adjust the volume of a track, adjust panning, mute and solo
tracks, etc. If you're the kind of person who only reads the bare minimum in
technical manuals, Chapter C should be the chapter you read.

System Requirements

In order to use the R1 Remote Controller, you need the following hardware and software:

= A MIDI interface

» Session 8 software version 1.1 or later, All software required by the R1 is incorpo-
rated into the Session 8 software itself. The most recent version of this application
has been included with your R1.

MNow get ready to install your R1 and get started using it with Session 8!

Digidesign R1 Remote Controller



Technical Specifications

= Height: 1.7 (at tallest edge).

* Width: 18.5"

* Depth: 10.6

= Weight: 6lb 13.5 0z

» Power Supply: 9 volt 1 AMP DC (positive tip/negative shield)
= Internal battery: Panasonic BR 2325

» MIDI IN/OUT: designed only for MIDI Sﬂ‘ldﬂ-‘ﬁfﬁi’ﬁ as defined in MMA Electrical
MIDI specification.

Chapter A: Introduction to the R1 Remote Controller
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Installing the R1 Hardware
and Software

Installing the R1 Hardware

Your R1 Remote Controller is easy to install in just a few steps. However, before you begin
installation, you must have a MIDI interface installed in your PC in order to use the R1. The
interface must by fully MPU-401 compatible, and be Windows and DOS compatible.
Configure your MIDI interface using the Windows Control Panel Drivers. Refer to your
Windows documentation or the MIDI interface’s documentation for more information.

First, make sure your MIDI interface is installed, connected and correctly configured, then
follow these steps:

* Connect the Power Supply to the R1 and plug it in.
= Connect the R1's MIDI Out to the MIDI In of your MIDI interface.
» Connect the R1's MIDI In to the MIDI Out of your MIDI interface.

This completes the hardware installation. Now you're ready to double-check a few software
parameters and start using the R1 in your sessions!

Chapter B: Installation 9




Installing and Configuring the Session 8 Software

Beginning with version 1.1, the Session 8 and Session 8 XL software ships with all R1
Remote Controller driver software already installed. Therefore, if you are sure that you have
this or a more recent version of Session 8/8XL (and you already have a MIDI interface
installed in your PC), you can skip this section and proceed to Chapter C, Overview.

NOTE: If you did not receive a Session 8 diskette, then your current Session 8 software
is already R1 compatible.

If you are not sure about your Session 8 software, you should follow these instructions to
make sure you are running the most current, R1-compatible version.

To Install the software Included with your R1:

« Insert the Session 8 Master Disk into a floppy drive of your PC. Make a note of
which floppy drive you have chosen.

= Launch Windows.
* Choose Run from the File menu in Windows.

* At the prompt, type the ID of the floppy drive containing the Session 8 Master
disk, followed by a colon and the word setup (one word, no spaces) and click OK.
For example, if you inserted the Session B disk into drive A, you would type A:sefup
If the Session 8 Master disk is in drive B, type Bisefup.

When you click OK, Windows will activate the floppy disk. You will be asked where
you want to install the new Session 8 software. You will probably want to overwrite
your old Session 8 software, 50 select that same drive and volume and click OK.

« Next, a window will appear telling you to restart your machine. Click OK.

« You will then see a window asking if you'd like to examine the contents of the
Read Me! file contained on the floppy disk. Click Yes. The Read Me! contains any
late-breaking updates that aren’t in the manual. Please read it before going any
further.

10
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» When installation is completed, you will return to Windows.

* Quit out of Windows and then restart your computer.

Installation is now complete! All that’s left is to confirm a few Preference settings within the
Session 8 software and you're ready to go.

Software Configuration

Your final task is configuring the MIDI parameters of Session 8 to recognize the R1.
« Launch Session 8. From the Options menu, select Midi. The Midi Setup dialog
appears.
» For Automation, single-click both the Send and Receive checkboxes for External Port.
Leave Internal Port settings unchecked.

« Set the MIDI Channel to Channel 1 by clicking on the arrow next to Midi Channel
and selecting Channel 1.

« Finally, at the bottom is a pop-up list for External Port Input and Output. Click on
the small arrow and choose the Driver appropriate for your MIDI interface from the
list. Click OK.

If necessary, consult your manufacturer’s manuals for more information on configuring
Windows, configuring your PC, or setting up your MIDI interface.

Chapter B: Installation 1
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Overview

Introduction

The R1 Remote Controller is a powerful, yet easy-to-use controller for Session B, Session 8
XL and other Digidesign digital recording and editing systems. This chapter provides a brief

review of each of the knobs, buttons and controllers on the R1.

To get started, let’s take a a look at the R1 top panel.

lewd—!nlhhluttml

B e

Trackbuttons ———— S O O OO 0 0O B &5

Track faders ———

The RT1 Remate Controler

Transport controls

Most of the controls of the R1 have direct correlation with Session 8's on-screen software
controls. For example, the Transport controls of the R1 are identical in function and
appearance to the Transport controls of Session 8. Some of the other controls might not be
this obvious. Read the following sections to become acquainted with the general functional-
ity of these and all other areas of the R1 Remote Controller. For detailed instructions on

using the R1 for specific tasks, refer to Chapter D, Using the R1.

Chapter C: Overview
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Faders
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The R1 Faders

The Track faders are numbered 1 through 8 and correspond to on-screen faders 1 - 8 in
either the Main Mix, Input Return, or Cue Mix of Session 8s Mix window. The Red bar
indicates the anity gain position for each fader. Select which of the fader sets (Main Mix,
Input Return or Cue Mix) you want the R1 to control by pressing the Optiorr button of the
1. You can learn how to do this in the section entitled Adjusting Levels with the R1, in
Chapter D, If an R1 fader gets “out of sync” witn an on-screen fader, you can reposition the
lem&mﬂmﬂmommwmmmmmnmdmm
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Stereo Master Faders is at the top of the fader.

Track Buttons

The Track buttons are located above each track fader.

L] L L] L] L] L] ¥ L]
—
B el g i e e i e

ﬂ====ﬂﬂ= ﬂ

R1 Track buttons, LEDs, and Record-Enable button

16
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These buttons work in conjunction with other function buttons on the R1 such as the
Mute, Solo, EQ, Sends and Pan buttons to select which tracks you want to mute, solo, EQ,
etc. For example, to mute a track, you first press the Mute Mode button and then press the
Track button of the track you want to mute.

Track LED's

Directly above each Track Button is one green and one red Track LED.

R1 is in Mute mode, the green LED will be lit on all muted tracks. The same goes for the

These LEDs indicate the Mode or Record-enable status of each track. For example, when the ‘
other Modes. When a track is record-enabled, the red LED will be lit on all record-enabled tracks.

Record-Enable button

Above the Main Fader on the R1 is the Record-Enable button.

—

Record-Enable button

In order to record any tracks, you must first depress the Record-Enable button (it will glow
red), and then press the Track button of the track(s) you want to record-enable.

Chapter C: Overview 17



Mode buttons

The Mode buttons include the Mute, Solo, EQ, Sends, and Pan buttons.

The R1 Mode buttons

These buttons switch a Session 8 track to the selected mode. In other words, if you press the
Mute Mode button (it will glow green), and then press track button #2, track #2 will be
muted. Similarly, if you press the Pan Mode button and then any Track button, the R1 will
allow you to pan that track. Mute, Solo, EQ, Effect Sends and Pan are all discussed in detail
in Chapter D, Using the R1.

Rotary Knobs

The Rotary Knobs 1 through 4 are used to adjust Effect Send levels, Panning, and EQ param-
eters, depending on which mode button is currently selected.

QO
Lo

The Rotary Knobs most obvious application is for adjusting the Effect Send levels of a track.
In this case, you would press the Sends Mode button, the desired Track button, and then
adjust Effect Send 1 by turning Rotary Knob 1, Effect Send 2 by turning Rotary Knob 2, and so on.

18 Digidesign R1 Remote Controller




Another use of the Rotary Knobs is for adjusting the Panning of a track. Actually, this only
involves a single Rotary Knob:Rotary Knob #2 (note the white line connecting the Pan
Mode button to Rotary Knob #2 on the top panel of the R1). To adjust the panning of a
Track, press the Pan Mode button (the Pan button will glow green), the desired Track button (the
Track LED will glow green) and then use Rotary Knob #2 to adjust the panning of that track.

Finally, the Rotary Knobs can be used to adjust the various EQ parameters found in the EQ
windows. Refer to the EQ section of Chapter D for information on using the Rotaries to
adjust EQ.

Mix/Edit/Route

Mix, Edit ond Route buttons

The Mix, Edit and Route buttons select the various Session 8 windows. Once you enter one
of these windows, the functions of the R1 User Buttons change to match that window.
Many controls, such as the Track faders and Master fader, work regardless of which window
you are in. Thus it is possible, for example, to adjust track levels while in the Edit window
without having to switch back to the Mix window.

Option button

oI
==

Option button

The Option button is used in the Mix window of Session 8 to select either the Main Mix,
Input Return, or Cue Mix. Pressing the R1's Option button toggles through these three mix
sections. You can tell which section is currently selected because its name glows red on-
screen. For more information on how the Option button is used in adjusting levels, see
Adjusting Levels with the R1, in Chapter D.

Chapter C: Overview 19




User Buttons

The User Buttons F1 through Fé are multi-purpose controls. Like the rotary knobs,their
function varies depending on which window you are currently in.

In the Mix window, the User Buttons do the following:

Group l-.i Croup 2 Esoun:e From
Group EE Group 4 Enoum:e To

When an EQ window is open, the User Buttons become:

Input Attenuator ; Curve ;-Toggll.- upper/lower EQ
E Curve 1lergpglf\! upper/lower EQ

In the Edit window, the User Buttons become:

Iomnﬂut\[ Zoom In ; Tool Select
S!-parlteE Capture 3 Loop on/off

Region Region

Bypass

20
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NOTE: You can see a diagram of the current functionality of the User Buttons by
choosing R1 User Buttons from the Window menu, or by pressing Control + U on your
computer keyboard.

Talkback button

The Talkback button functions just like a talkback button on a regular mixing board,
whether you are in the Mix, Edit or Route window. It sends whatever signal is routed to the
Talk Stereo Bus to the Cue outputs (3 and 4) and to the Headphones.

O

Talkback button

A microphone must first be connected and routed for Talkback. To configure Talkback in
Session 8, simply open the Route window and patch the microphone to the Stereo Bus channel
Talk. On the Audio Interface, set the Phones switch to Cue. Connect your cue system to Cue
outputs 3 and 4, or to the Headphones jack(s) on the front of the Session 8 Audio Interface,
and you should be ready to go.

Autolocate buttons

The Autolocate buttons include View, Assign, To, and the numbered Marker buttons.

These buttons allow you to assign and use autolocate points and markers. Refer to Autolocate
Confrols in Chapter D for more information.

Chapter C: Overview 21




Transport

The Transport controls of the R1 are identical in layout and function to Session 8's transport.

If you need additional information on using the Transport controls of the R1, refer to Using
the Transport Controls in Chapter D.

Digidesign R1 Remote Controller



Chapter D
Using the R1

i 8 L E m
CONTROLLER




_Using the R1

Before you Begin_

You are probably anxious to start using your R1 Remote Controller. This chapter will show

@mmnyﬁ'mdmmﬁmpmtmmmmmmmmpma
Installation. It is also assumed that you are familiar with your Session 8,
Before you start, check the following;

* Check to make sure your MIDI connections are correct (i.e., the MIDI OUT of the
R1 is connected to the MIDI IN of your MIDI interface, and the MIDI IN of the R1
is connected to the MIDI OUT of your MIDI interface)

« Check to make sure that the R1 is switched to the PC position. On the back panel
of the R1 is a three position power switch. Looking at the R1 from the back, center
position is OFf, left is On for Mac, and right is On for PC.)

/vau'mrih:h
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The R1 back panel

?@?

* Also, start up Session B if you have not already done so.

| NOTE: If the R1 LEDs flash on and off when you turn the unit on, it is an indication
that the internal battery is low. Pressing any button on the R1 will stop the unit from
flashing. If this occurs, call Digidesign Technical Support for instructions.

Chapter D: Using the R1 25



The R1 Remote Controller

Here is a diagram of the R1 Remote Controller, and the location of each of its controls.

Track buttons —

Track faders —
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Getting Started: Opening the Mix, Edit and Route Windows

Since the Mix window is where most of your recording and mixing takes place, this chapter
will first show you how to use the R1 in the Mix window. You'll learn how to use the

transport controls, adjust track levels, panning, effect sends and EQ, group tracks, and so
on. After that, we'll cover what the R1 can do in the Edit window.

You can use the R1 to switch between the three Session 8 windows:

To select the Mix, Edit and Route windows with the R1:

* In the upper right hand corner of the R1 are the Mix, Edit and Route buttons, Press
the Mix button and Session B will switch to the Mix window on screen. Similarly,
press the Edit button to show the Edit window, and the Route button to show the
Route window. ;

NOTE: There are no R1 controls specific to the Route window. However, many con-
trols, such as the faders and Talkback button, work while the Route window is open.

If Session 8 does not switch to the Mix, Edit or Route windows, try moving the faders of the
R1 and check if the Session Bs on-screen faders move. If they do not seem to be working
either, check your MIDI connections and power cords. Check to make sure the R1 power
switch, on the back panel of the unit, is set to PC. Make sure your MIDI interface is properly
installed and connected. If necessary, reinstall the Session 8 software from the floppy disk that
came with your R1. Be sure to carefully follow the installation instructions in Chapter B.
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Using the Transport Controls

The Transport controls of the R1 are laid out identically to Session 8's transport buttons.
From left to right, the transport buttons are as follows:

Return to Zero Rewind Stop Play FPwd Record
Transport controls

* Return to Zevo. This button moves the Play Point to Zero, or the beginning of the
song.

* Rewind. This button moves the Play Point towards the beginning of the song for as
long as the button is held down.

» Stop. This button stops playback or recording.

* Play. This button begins playback from the Play Point. It also initiates recording
when a track has been record-enabled and the record button depressed.

* Fast Forward, This button moves the Play Point towards the end of the song for as
long as the button is held.

* Record. This button places Session 8 into record-ready when one or more tracks are
record-enabled.

The Transport buttons work the same in the Mix, Edit and Route windows.
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Adjusting levels with the R1

The K1 makes adjusting fader levels much easier. The R1 faders can be used to control the
Input Return, Cue Mix and Main Mix faders. Use the Option button to jump between these
three areas in the Mix window.

To adjust a Main Mix fader with the R1:

# Press the Option button of the R1 until the Main Mix is selected. You will be able to
tell because “Main Mix" will appear in red.

* Move the R1 fader that corresponds to the Main Mix fader you want to adjust.
Move R1 fader #1 to adjust Main Mix fader #1, R1 fader #2 to adjust Main Mix
fader #2, and so on.

To adjust an Input Return fader with the R1:

= Press the Option button of the R1 until the Input Return section is selected, or click
anywhere in the Input Retumn area. The words “Input Return” will turn red when
selected on a color monitor, and lighter grey on monochrome monitors.

= Move the R1 fader that corresponds to the Input Return fader you want to control.

To adjust a Cue Mix fader with the R1:

= Press the Option button of the R1 until the Cue Mix section is selected.

= Move the R1 fader that corresponds to the Input Return fader you want to control.

As you use the R1 to adjust faders in the three sections of the Mix window, it might become
necessary to reposition one or more faders without actually adjusting an on-screen param-
eter. For example, let's say you set the Cue Mix level for track 6 to 75%, then press the
Option button to select the Main Mix. On screen, track 6 in the Main Mix might be all the
way off, but the R1 fader for Track 6 is still at the 75% position. In this type of situation, you
would use the Clutch button to reposition the R1 fader to match the on-screen setting,
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To reposition an R1 fader:

» Press and hold down the Clutch button of the R1.
= Reposition the fader to the desired location.

* Release the Clutch.

Recording with the R1

When you record tracks with the R1, you will use a combination of buttons. First, you will
“arm” the individual track or tracks to be recorded, and then use the R1 Transport controls to
initiate recording.

To Record a track with the R1:
= Press the Record-enable button near the top of the R1.

» Press the Track buttons of the track(s) you want to record. This record-enables the
track(s) in Session 8. The LEDs above each record-enabled R1 track glow red. (Tracks
can only be record-enabled or record-disabled when the Record button is red.)

« Press the Record button on the R1 transport. The red Record light will blink when
Session B is record-ready.

At this point, additional tracks cannot be record-enabled nor can record-enabled
tracks be disabled until you take Session 8 out of record-ready. You can then
record-enable additional tracks as described above, or take tracks out of record-
enable by pressing the appropriate Track button (the red LED above the track will
stop glowing when out of record-enable).

« Press the Play button on the R1 transport to begin recording. The red Record LED
will glow (instead of blinking) when recording is taking place.
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* To stop recording, press the Stop button.

NOTE: The R1 does not have any controls for saving takes or sessions. This must be
done with the mouse and computer keyboard as described in your Session 8 User’s Guide,

Muting and Soloing tracks with the R1

To Mute or Solo a track with the R1, you will use a combination of buttons. First you will
use a Mode button to select Mute or Solo, then Track buttons to designate which tracks to mute or
solo.

Mode buttons
To Mute a track, or tracks, with the R1:

* Press the Mute mode button on the R1. The Mute button will glow green when
engaged.

» Press the Track button of the track(s) you want to mute. The Track LED on the R1
and the Mute button for that track on screen will glow green when muted.

* To unmute a track, press the Track button again.
To Solo a track with the R1:

* Press the Solo mode button of the R1. The Solo button will glow yellow when
engaged.

* Press the Track button of the track you want to solo. The Track LED in the R1 and
the corresponding Solo button on screen will change color to verify Solo status.

*» To unsolo a track, press the Track button again.
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Effect Sends

The four rotary knobs on the R1 can be used to adjust the Effect Send level on any track in
the Main Mix and Input Return areas of the Mix window using a combination of the Seruds
Mode button and the Track buttons. The Rotary Knobs only function this way when you are
in the Mix window.
To adjust an Effect Send level for a track:
= Press the Option button to select the Input Return or Main Mix.
» Press the Semds Mode button. It will glow green.

» Press the desired Track button. The four rotary knobs of the R1 will now adjust the
corresponding Effect Send level of the selected track.

* Adjust the Effect Send levels for the selected track using the R1's four rotary knobs.

® O
©©

Rotary Knobs
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EQ

With the R1, you can control all Session 8 EQ parameters using a combination of User
Buttons, Track Buttons, and Rotary Knobs. Each EQ module provides cut/boost, bypass,
curve and frequency controls. Session 8 lets you place as many as four EQ modules in a
single track. Here is a diagram of a single EQ module:

A Session 8§ EQ Module

The basic procedure for adjusting EQ with the R1 is to first open the EQ window of the track
you want to adjust, then use the User Buttons and Rotary Knobs to change EQ parameters.

To open an EQ window with the R1:

*= Press the Option button to select the Input Return or Main Mix area of the Mix
window containing the EQ you want to open.

*= P'ress the EQ Mode button. The EQ Mode button will glow green.

= Press the desired Track button. If there is one or more EQs assigned to the track, the
EQ Window will open and display the current EQ settings. If you want to close the
EQ window, press the Track button again.

If there is no EQ assigned to that track, nothing will happen — you must first have
an EQ placed on that track. (If you do not know how to do this, refer to your
Session 8 User's Guide.)
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To adjust the Input Attenuator of an EQ:

* Press and hold down User Button F1, and then turn Rotary Knob 2.

To Bypass the EQ:

* Press User Bution F4 to toggle the bypass feature on and off.

To adjust the EQ parameters:
* To adjust the boost/cut of the topmost EQ module, turn Rotary Knob 1.
» To adjust the frequency of the topmost EQ, turn Rotary Knob 2.

* To choose the Curve options for the topmost EQ, press User Button F2.

To adjust the parameters of a 2Znd EQ (if there are two assigned to the track):
= Use Rotary Knob 3 to adjust the boost/cut of the second EQ.
= Use Rotary Knob 4 to adjust the freguency of the second EQ,

* Press User Button F5 to toggle through the Curve options for the second EQ.

To adjust the 3rd, or 4th EQ (if there are more than two EQs assigned to the track:

* Press User Button F3 or F6 to toggle between the upper two EQs and the lower two
EQY's. The boost/cut and frequency knobs of the selected EQs will glow a lighter
shade of blue.

With the lower two EQ's selected, the rotary knobs and user buttons function as
described earlier except that they now apply to the third and/or fourth EQ module.
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To close the EQ window:

» Press the Track button of the track that the EQ is on. The EQ window will close.

Quick-reference of EQ controls:

W

Input Attenuator Curve Toggle upper/lower EQ

A B B
Bypass Curve Toggle upper/iower EQ

Input Attenuator - Hold down FI, turn any Rotary Knob

Bypass - Press F4 to toggle bypass
Boost/Cut - Rotary Knob 1
Frequency - Rotary Knob 2
Curve - Press F2
Boost/Cut #2- Rotary Knob 3
Frequency #2 - Rotary Knob 4
Curve #2 - Press F4

To adjust the parameters of a 3rd and/or 4th EQ module in the same window, press F3 or F6
to toggle between the upper two and lower modules and then use the same controls listed
above. The current module is identified by its boost/cut and frequency knobs glowing a
lighter shade of blue.
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IMPORTANT

You can view a “map” of the current User Button functionality by opening the RI User
Buttons window.

To view the current User Button functionality:

s Choose R1 User Buttons from the Window menu of Session 8. Or, press Control+U on
your computer keyboard.

The R1 User Buttons window will appear. This window shows you what functions
the eight user buttons perform in the current window. For example, while an EQ
module was open in the Mix window, you would see something like this:

L T .
T e |

Input Attenuator  Curve Toggle upper/lower EQ

M K R
o —

Bypass  Curve Toggle upper/lower EQ

This feature is handy for helping you remember what each of these multiple-
purpose buttons do in the various Session 8 windows. It is available from the
Window menu in all three Session 8 windows.

# Click OK to close the R1 User Buttons window.
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Pan

The R1 lets you adjust the panning of any track. To do this, you will use a combination of
Mode buttons and Track buttons, and one of the Rotary Knobs.

To adjust the panning of a track:

» Press the Option button to select the Main Mix or Input Return section of the Mix
window, as desired.

= Press the Pan Mode button.
» Press the Track button of the track you want to pan.

* Use Rotary Knob 2 to adjust panning for the selected Track. Only Rotary Knob 2 will
adjust panning. -

Autolocate controls

The R1 lets you assign and select autolocate markers, as well as select the audio range
between two markers. Located directly above the R1's Transport controls, the Assign, View,
To and numbered Marker buttons provide controls for using autolocate points.

Markers can be placed and located in either the Mix or Edit window. However, they are only
visible in the Edit window. For this reason, you will need to switch to the Edit window for
this portion of your manual. For more information on using the R1 in the Edit window,
refer to the section Using the R1 in the Edit Window later in this chapter.

The basic procedure for setting markers is to begin playback, then press the Assign button,
and when playback reaches the point at which you want to set a marker, press a numbered
Marker button.
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To place a marker using only the R1:
* Open the Edit window by pressing the Edit button of the R1. The Edit window opens.

» Press the Assign button. The Assign button glows red.

= Press Play to begin playback.

= When playback reaches the point where you want to place your marker, press one of the
numbered Marker buttons on the R1. Session 8 will place that marker at that point.

= To set additional markers, continue playback and repeat the previous steps.

To reset a marker:
* Press the Assign button of the R1.
» Press Play to begin playback.

« When playback reaches the point to which you want to reset the marker, press that
marker number. The R1 will reset the marker to the new location.

To playback from autolocate points:

« Press the appropriate Marker button. Session 8 will move the play point to that
marker location.

* Press Play.

To select audio between two markers:

« Press the marker at the beginning of the desired selection. The overview display
and the play point will move to the location of the marker.

= Press the To button of the R1.

= Press the marker at the end of the desired selection. The audio between your From
and To markers will become highlighted.
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a marker location without moving the play point:

» Press the View button.

» Press the appropriate Marker button. The overview display will move to the
locations of the marker, but the play point will not change.

NOTE: The R1 lets you control many other Edit window functions as well, including
me{mloopthndumdreglun},ﬂpmuwmmdmm.MMou
information, refer to the section, Using the R1 in the Edit Window later in this chapter.

Grouping Tracks with the R1

The R1 provides a quick way to group tracks, using a combination of User Buttons and Track
faders. Grouping tracks is possible from the Mix window only. The basic procedure is to first
use the appropriate User Button to select a Grouping Color, then indicate which track or

tracks you want in that group.

To group tracks with the R1:

« Press and hold down the User Button that corresponds to the Grouping Color you
want to apply — F1 selects the Green group, F2 the Yellow group, F4 the Pink group,
and F5 the White group.

« While still holding down a User Button, nudge the faders of each track you want
grouped until you see the on-screen fader change to the correct group color. Don't
worry about this disturbing your fader levels — although the color of the fader will
change to reflect its grouping, its on-screen position and actual level will not be
modified while a User Button is held down.

= Repeat to set up other groups.

» To ungroup tracks, repeat the procedure for grouping (i.e,, hold down the appropri-
ate User Button, then nudge the grouped track fader until the color of the on-
screen fader changes back to blue.)
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NOTE: You can see a diagram of the current functionality of the User Buttons by
choosing R1 User Buttons from the Window menu, or by pressing Control + U on your

computer keyboard.

Bouncing Tracks with the R1

You can set up track bouncing with the R1 by using a technique similar to Grouping. The
basic procedure for bouncing tracks is designate the tracks to be bounced, and then desig-
nate the destination tracks for the bounce.
To bounce tracks with the R1:
» In the Mix window, press and hold down User Button F3.
« Nudge the fader of each track you want to bounce from. As you do so, each
“bounce from” track will glow blue. Don't worry about your fader levels — their
position is not changed when the faders are nudged to designate Bounces.
« After designating each “bounce from” track, press and hold down User Button F6.

 Nudge the fader of each “bounce to” track. As you do so, each “bounce to" track
will glow red.

« Set Session 8 into record mode and record your bounce. Be sure to save your takes!
» To take tracks out of bounce mode, repeat the steps for setting bounce tracks (i.e.,

hold down F3 or F6 and nudge the track faders). The tracks will return to their
normal color.
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Using the R1 in the Edit Window

While working in the Edit window, you can use the R1 to control autolocate markers, select
audio between markers and to select different tools. The Autolocate controls were explained
in the earlier section Autolocate Controls. Refer to this section for information on assigning,
resetting, playing back from, and selecting audio between markers.

When in the Edit window, you can select different tools and commands with the User
Buttons. These buttons select the enlarge/reduce display scale arrows, tab through each of
the main tools, toggle Loop on and off, and perform Capture Region and Separate Region
commands.

The Mute, Solo and Record Enable functions work the same in the Edit and Mix windows.
Therefore, refer to previous sections of this chapter for information on muting, soloing or
recording tracks.

NOTE: You can see a diagram of the current functionality of the User Buttons by
choosing R1 User Buttons from the Window menu, or by pressing Control + U on your
computer keyboard.

To zoom out using the Display Scale arrows:

e Press User Button F1. To zoom further out, press F1 again.

To reduce the time scale using the Display Scale arrows:

* Press User Button F2. To zoom further in, press F2 again.

To select the Zoomer, Waveform Selector or Pointer with the R1:

* Press User Button F3 until the tool you want to use is selected.

To activate/deactivate Loop:

* P'ress User Button F&. This button will toggle the Loop tool on/off.
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To deselect any tool, press the appropriate User Button again.

You can use the R1 to capture and separate Regions in the Edit window. This makes it easier
for you to perform many of your editing tasks without ever having to use the mouse.

The basic procedure for capturing and separating regions with the R1 is to first make a
selection of audio, then capture or separate that Region. Of course, you don’t have o use
just the R1 for any phase of your editing. You can use any combination of Rl controls,
mouse actions or keyboard commands to select, audition, capture or separate Regions.

To select audio between two markers:

« Press the marker at the beginning of the desired selection. The overview display
and the play point will move to the location of the marker.

» Press the To button of the R1.
« Press the marker at the end of the desired selection. The audio between your From
and To markers will become highlighted.
To separate a Region with the R1:
» Select a part of a displayed waveform.
* Press User Button F4 (Separate Region).

* The Region Info box appears. Enter a name for the new Region and make the
appropriate choices for Color and Update Overview Data.

« Click OK. The dialog box will disappear, and the new Region will be created, placed
in the track, and automatically selected in the same location as your original
waveform selection.
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capture a new Reglon:
* Select a part of a displayed waveform

* Press User Button F5 (Capture Region).

= The Region Info dialog will appear.

= Enter the appropriate information in the Region Info dialog and click OK. You'll
see your new Region name appear in the Audio Regions List at the right side of the
Edit window.

The R1 also lets you move the overview display to a marker without disturbing your
selection. Essentially, this feature lets you view a marker which you can't currently see. This
is handy for checking other points in your session before capturing or separating a region,
perhaps to compare start and end points.

To view a marker without moving the play point:
* Press the View button.

* Press the appropriate Marker button. The overview display will move to the
location of the marker, but the play point will not change.

IMPORTANT

Please refer to your Session 8 User's Guide for information on using the Separate with Silence
option in the Preferences dialog box. This option is very convenient when using the Separate
Region command. When this Preference is turned on, a Silent Region is automatically created
and placed exactly beneath a newly Separated Region. Refer to your Session 8 User's Guide
for more information.

This concludes your R1 User’s Guide. We hope you enjoy using it in all your Session 8
projects!
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